
Intel Office PCI3 
 
Intel Office is used to analyze and update intelligence data.  A network connection to an 
ISDS is required to access intelligence data.  Once connected, intelligence data can be 
viewed and modified.  Intel Office is now loaded on the MEF-IAS Client, IOW, IOS V2 
Client and MEF-IAS E-Server.  

Launching Intel Office  

1. To launch Intel Office: 

?? Go to the Start menu, choose Programs , choose Intel Office, and select 
StartIO from the menu. 

The Intel Office application launches (see Figure 1-1).  

 

Figure 1-1. Intel Office Workspace 

 
 
 



2.  Changing Optional Settings 
Intel Office is customizable to suit your preferences and work requirements (See Figure 
1-2).  
You can set the following preferences: 
 

?? Setting the Default IFA Level Preference 

?? Applying Falcon View 

?? Setting the Observation Search Preference 

?? Setting Associations and Observations Preference 

?? Setting the Data Path 

 

Figure 1-2.  Options  

NOTE: It is not necessary to set the Decode Preference or Apply Geo Search options; 
they have no function associated with setting them as a preference. 



 
Setting the Default IFA Level Preference 
 
Use the Default IFA Level Preference option to set the lowest level the IFA Search tree 
expands to. 

3. To set the default IFA level: 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-2). 

Step 2. Set the default IFA level by expanding/collapsing the IFA tree.   

Step 3. Highlight the desired IFA level to query to. 

Step 4. Click OK.  

Applying Falcon View 

4. To apply the Falcon View settings: 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-2). 

Step 2. Apply setting by selecting the Web Links on radio button. 

Step 3. Click OK. 

Setting the Observation Search Preference 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-2). 

Step 2. Go to the Observation Search Preference section of the window and use 
the Up and Down Arrows  to specify the Number of Days to query for 
Observations. 

Step 3. Click OK. 

Setting Associations and Observations Preference 

5. To set the Associations preferences: 

Step 1. From the Intel Office workspace, go to the Intel menu and select Options .  

 The Options window appears (see Figure 1-2). 



 

Step 2. Click the Associations and Paths  tab (see Figure 1-3). 

 

Figure 1-3.  Associations and Paths  

Step 3. Select the Check Box next to each Association you wish to include in your 
query. 

NOTE: Selecting Subordinate Units or Subordinate Facilities will return ALL Units and 
Facilities associated with your search, not only the Subordinate Units or 
Facilities. 

Step 4. Click OK. 

  Setting the Data Path 



6. To set the default location for your personal folder (My Products): 

NOTE: This folder will be where the users queries will be saved.  The type of extension 
used for saving files in Intel Office is .xls.     

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-3). 

 Select the Associations  and Paths  tab. 

Step 2. Set the default location for your personal folder (My Products) by 
browsing the hard drive. 

Step 3. Click OK.  

7. To set the default location for the public Intel folder (Publish My 
Products): 

All saved Publish to Web files are saved in the public Intel folder specified in this 
procedure.  This directory is normally your activity’s web directory. 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-3). 

 Select the Associations  and Paths  tab. 

Step 2. Set the default location for the public Intel folder by browsing the hard 
drive. 

Step 3. Click OK.  

8. To set the location To View Other’s Products: 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-3). 

 Select the Associations  and Paths  tab. 

Step 2. Set the data path to view other’s products by browsing the hard drive. 

Step 3. Click OK. 



9. To set the location To Send Quiver Target Data: 

Step 1. From the Intel Office workspace, go to the Intel menu, and select 
Options .  

 The Options window appears (see Figure 1-3). 

 Select the Associations  and Paths  tab. 

Step 2. Set the path by selecting Browse to browse the hard drive. 

Step 3. Click OK. 
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Searching the Intelligence Shared Data Server (ISDS) 

Introduction to Searches 
Intel Office provides several methods to retrieve information from the ISDS; the IFA 
search, Facility Search, Unit Search, Observation Search and the Geo Search. 

Performing an IFA Search 
Intelligence Functional Areas (IFAs) are used to search for intelligence data.  Each IFA is 
a collection of similar data.  For example, the IFA Air Order of Battle (AOB) combines 
intelligence data such as airfields, bomber units, tanker units, and rotary wing units.  
When the analyst creates a search, they will use IFAs to determine what types of 
intelligence data they want to view. 

Each IFA contains fields.  Fields contain descriptive data about a specific IFA.  For 
example, a search could be created to return all air facilities that are operational. 

 
 
 
 
 
 
 
 
 
 
 



10. To perform an IFA Search:  

Step 1. Go to the Intel menu and select Search, or click Search on the Intel 
Office Toolbar at the bottom of the screen. (See Figure 1-4) 

 

Figure 1-4 Intel Menu and Tool bar 

  

 The Search Tool window appears.  (See Figure 1-5) 



 

              Figure 1-5 Search Tool Window IFA Search 

NOTE: The Geo tab in Figure 1-5 is used when doing a GeoSearch.  For more 
information on GeoSearch. 

Step 2. In the top field on the Options Tab select IFA Search.  The list of IFA 
searches available is shown.   

The IFA list expands if additional levels of detail exist.  You can set the 
levels of the IFA drill down in the Options window (see Section 2,  
Changing Optional Settings).  

Listings that can be expanded to more specific IFA categories will have a 
plus (+) in the box before it.  Figure 1-1-5 shows the root level IFAs with 
a plus (+) in the box before each expandable IFA.  The + can be clicked to 
display more specific IFA categories.  Once a + box is clicked, a list of 
more specific IFAs is displayed.  The + will be replaced with a minus sign 
(-). 

Step 3. Continue navigating through the IFA tree until the level of detail desired 
to search is reached.  



 
Figure 1-6 shows the drilldown navigation in the Air Order of Battle (AOB) IFA. 

 

Figure 1-6.  Search Tool Window IFA Drilldown AOB 

NOTE: In Figure 1-6 the AOB IFA has been expanded (note the minus sign (-) in the 
box before it).  Under the AOB IFA, there are multiple sub-categories.  Each 
one of the sub-categories can be further expanded (note the plus sign (+) in the 
boxes).  In the above example, the Air Order of Battle IFA has been expanded.  

Step 4. Double-click on desired IFA in order to enter matching criteria.  

 The IFA options window appears which allows you to enter matching 
criteria for your search (see Figure 1-7).   

11. To enter matching criteria: 

Step 1. Select a field to search for within the IFA Options Window.  Some fields 
will have a pull down arrow on the right of the field.  Select the pull down 
menu to choose specific criteria. (Figure 1-7 shows the Country fields pull 
down open).  



 Table 1-1.  IFA Search Matching Criteria Definitions for more 
information on and examples of entering the matching criteria. 

 

Figure 1-7. Search Tool Window IFA Search Criteria 

Step 2. Enter the values to search in the IFA Options fields.   

NOTE: If the user is entering more than one value in a field, the multiple values need to 
be separated with a comma (AA, AG, AL…etc).  For single values use the drop 
down menu to select the code you want, or type the code in the field for those 
fields without drop down menus. 

Step 3. You can narrow your search further by selecting more IFA Options  to 
search, or by selecting the Geo tab to narrow your search by a specific 
location. 

Step 4. When finished entering the options to search, select Search Now. 

A Searching Progress window appears (see Figure 1-8) and the records 
matching the search criteria begin to populate the spreadsheet. 



 

Figure 1-8. Search Progress 

Examples of how to use the search matching criteria are listed in Table 1-1. 

Table 1-1.  IFA Search Matching Criteria Definitions  

Search Matching Criteria Definition Example 
Associated Equipment Name  Indicates the equipment family and 

provides the nomenclature 
describing it. 

Question:  Find all units that 
have T-72 Tanks.  
Solution:  Select the GOB 
IFA Search and enter T-72 in 
the Associated Equip field 
and the wildcard symbol * in 
the Unit field. (See note 
below for wildcard * 
information.) 

Echelon The level or point at which a unit 
exists within an organizational 
structure. 

Question:  Find all Iraqi units 
that are at the Corps level. 
Solution:  Select the Unit 
IFA search and enter Corps in 
the Echelon field, the Iraq 
country code IZ in the 
Country field and * in the 
Unit field. 

Country Facilities: Country in which the 
geographic coordinates reside 
(country code). 
Units: The country or political 
entity to which the entity owes its 
allegiance (allegiance). 

Question: Find all the air 
related units and facilities for 
Iraq.  
Solution: Select the AOB 
IFA and enter IZ in the 
country code window to 
return these results.  

Facility Name/Unit Name Official name of the facility or unit.  Question: Find all 
communications facilities and 
units with the name beginning 
with Baghdad. 
Solution: Go to the C4I IFA, 
and select Communications 
Units and Facilities, enter in 
the name Baghdad* in the 
name field. 

Top Progress Bar shows 
the progress of the current 
search. 

Bottom Progress Bar 
shows the progress of 
the whole search. 



Search Matching Criteria Definition Example 
Operational Status The readiness of an entity to 

perform its primary function.  
Question: Find all 
operational SAM sites for 
Iraq.  
Solution: Go to the MOB 
IFA, and choose operations, 
then select SAM sites and 
enter in OPR in Operational 
Status, and IZ in country 
code. 

Percent Effectiveness The measure of the ability of a unit 
to wage war expressed as a 
percentage.   

Question: An imagery 
analyst changes a site to 
be 50 percent effective.   

Solution: Go to the IFA 
and enter in site name in 
the Name field and 50 in 
the Percent Effectiveness 
field. 

 

NOTE: The asterisk * symbol can be used as a wildcard for searching for information.  
This can be used when the user wishes to retrieve something they are not sure 
of, for example if they know a partial name of a facility, they can type the letters 
know followed by * which will return all facilities that begin with those letters.  
It can also be used for an all-encompassing search as in searching all units, 
simply type the * in the units field and it will return all units for your search. 

 
Performing a Facility Search 

12. To perform a Facility Search: 

Step 1. Go to the Intel menu and select Search, or click Search on the Intel 
Office Toolbar at the bottom of the screen. 

Step 2. In the top field on the Options Tab select Facility Search (see Figure 1-9). 



 

             Figure 1-9.  Facility Search Window 

Step 3. Enter the values to search in the Facility Options fields.   

NOTE: If the user is entering more than one value in a field, the multiple values need to 
be separated with a comma (AA, AG, AL…etc).  For single values use the drop 
down menu to select the code you want, or type the code in the field for those 
fields without drop down menus. 

Step 4. You can narrow your search further by selecting more Facility Options , 
or by selecting the Geo tab to narrow your search by a specific location. 

Step 5. When finished entering the options to search, select Search Now. 

A Searching Progress window appears and the records matching the 
search criteria begin to populate the spreadsheet. 

Performing a Unit Search 

13. To perform a Unit Search: 

Step 1. Go to the Intel menu and select Search, or click Search on the Intel 
Office Toolbar at the bottom of the screen. 

      Step 2. In the top field on the Options Tab select Unit Search (see Figure 1-10). 



 

Figure 1-10.  Unit Search Window 

Step 3. Enter the values to search in the Unit Options fields.   

NOTE: If the user is entering more than one value in a field, the multiple values need to 
be separated with a comma (AA, AG, AL…etc).  For single values use the drop 
down menu to select the code you want, or type the code in the field for those 
fields without drop down menus. 

Step 4. You can narrow your search further by selecting more Unit Options , or 
by selecting the Geo tab to narrow your search by a specific location. 

Step 5. When finished entering the options to search, select Search Now. 

A Searching Progress window appears and the records matching the 
search criteria begin to populate the spreadsheet. 

Performing an Observation Search 

Step 1. Go to the Intel menu and select Search, or click Search on the Intel 
Office Toolbar at the bottom of the screen.  

Step 2. In the top field on the Options Tab select Observation Search (see Figure 
1-11). 



 

Figure 1-11.  Observation Search Window 

Step 3. Enter the values to search in the Observation Options fields.   

NOTE: If the user is entering more than one value in a field, the multiple values need to 
be separated with a comma (AA, AG, AL…etc).  For single values use the drop 
down menu to select the code you want, or type the code in the field for those 
fields without drop down menus. 

Step 4. You can narrow your search further by selecting more Observation 
Options , or by selecting the Geo tab to narrow your search by a specific 
location. 

Step 5. When finished entering the options to search, select Search Now. 

A Searching Progress window appears and the records matching the 
search criteria begin to populate the spreadsheet. 



Performing the Geo Search 
Use the Geo Search to filter search results based upon a geographical area.   

NOTE: You must have C2PC open in order to perform a Geo Search. 

14. To perform a Geo Search: 

Step 1. Open C2PC. 

Step 2. Open Intel Office and select Search. 

Step 3. Enter criteria to search in the IFA, Facility, or Unit Search window and 
then choose the Geo tab. 

Step 4. Select either Box or Circle from the Geo Search Options  (see Figure 
1-12).  This will allow you to draw a shape around a certain area on the 
C2PC map. 

 

                Figure 1-12.  Geo Search Window 

Step 5. Bring up the C2PC map and select the area to search by drawing a Box or 
Circle around that area. 



Step 6. Once the area is selected, go back to the Geo Search Options  window 
and select Search Now. 

Records will then be returned to the spreadsheet matching your search 
criteria chosen within the specific area selected on the C2PC map.   

NOTE: The records returned to the spreadsheet from the GeoSearch can be plotted to 
the C2PC map.  To do so Track Plot must be selected from the Tools menu in 
C2PC.  After Track Plot is selected, highlight the records to plot to the map 
and select Plot to Map from the Intel menu in Intel Office. 

Using Land Track Query  
The Land Track Query tool, accessed from C2PC, allows you to query and plot directly 
to the map using predetermined queries, represented by symbols.  The queries are 
organized into 10 primary types and 28 sub-types.  Choosing a primary type 
automatically includes the corresponding sub-types.  More than one type/sub-type may be 
chosen for a query.   

NOTE: The primary types and sub-types used in Land Track Query are similar to, but 
not the same as, the IFAs used in Intel Search.   

You have the capability to limit the query by geographic area using latitude/longitude or 
military grid coordinate systems.  Unlike Intel Search, you cannot save query criteria 
using Land Track Query.   

Overview of the Land Track Query Window 

All of the Land Track Query functions are accessed through one main window, accessible 
via C2PC.  

To open the Land Track Query window: 

Step 1. Start C2PC. 

Step 2. Go to Tools menu and select Track Plot.  The Track Plot pane opens on 
the left side of the C2PC Map. 

Step 3. Go to the Track Plot menu, and select Land Track Query. 

The Land Track Query window appears (see Figure 1-13). 



 

Figure 1-13.  Land Track Query Window 

Menu Bar 
You can access functions through the menu bar.  Functions include Run Query and 
Help.  You can also choose the type of data you will be querying on.   

Toolbar 

Like the menu bar, the toolbar provides access to the most commonly used functions.  
Clicking a button rather than choosing a menu item accesses Toolbar functions.  Some 
functions, such as Run Query, are available both through the menu and toolbar.  Other 
functions are only available through either the menu or the toolbar. 
 
Table 1-2.  Land Track Query Toolbar is a listing of important toolbar icons. 

Table 1-2.  Land Track Query Toolbar 

Icon Name Function 

 

Run Query Runs a selected query.  In most cases, running a query will 
plot tracks on the map. 

 

Select All Selects all IFA symbols.   



Icon Name Function 

 

Deselect All Deselects all the IFA symbols.   

 

Select All Units Selects all the Unit IFA symbols. 

 

Select All Facilities  Selects all of the Facility IFA symbols.  

 

Draw Box  Limits your query results to a specific area on the map.  
After clicking this icon, you will be able to draw a box on 
the map.  Only tracks that are within the box are returned 
by the query. 

 

Draw Circle Limits your query results to a specific area on the map.  
After clicking this icon, you will be able to draw a circle 
on the map.  Only tracks that are within the circle are 
returned by the query. 

 

Draw Polygon  Limits your query results to a specific area on the map.  
After clicking this icon, you will be able to draw a polygon 
on the map.  Only tracks that are within the polygon are 
returned by the query. 

 

Draw Route Limits your query results to a specific area on the map.  
After clicking this icon, you will be able to draw a route on 
the map.  Only tracks that are along the route are returned 
by the query. 

 

Default Searches within the area of the map visible on the screen. 

 

Help Accesses online help 

Query Criteria 
The Query Criteria area contains symbols representing predetermined queries. The 
queries are organized into ten primary types and 28 sub-types.  Choosing a primary type 
automatically includes the corresponding sub-types.  More than one type/sub-type may be 
chosen for a query. 
For example, clicking on the Artillery Order of Battle (ARB) symbol will create a query 
that returns Anti-Aircraft Artillery (AAA) and Field Artillery (FA) tracks. 
The Land Track Query symbols are as follows:  

?? ARB (Artillery Order of Battle)  

?? AAA (Anti-Aircraft Artillery)  

?? FA (Field Artillery)  

?? AMP (Amphibious)  

?? CLB (Coastal Landing Beaches)  

?? HLA (Helicopter Landing Areas)  

?? AOB (Air Order of Battle)  

?? UNT (Air Units)  

?? AFI (Airfield Inventory)  



?? ASF (Airfield Support Facility)  

?? CHP (Choke Points)  

?? CHK (Choke Points)  

?? LOC (Lines of Communication)  

?? BRG (Bridges)  

?? FAC (Transportation Facilities)  

?? EOB (Electronic Order of Battle)  

?? EW (Early Warning Radar)  

?? GCI (Ground Control Intercept)  

?? FC (Fire Control Radar)  

?? RDR (Special Electronic Devices)  

?? GOB (Ground Order of Battle)  

?? UNT (Ground Units)  

?? GFI (Ground Force Installations)  

?? INS (Military/Non-Military Installations)  

?? MIL (Military Installations)  

?? MIS (Non-military Installations)  

?? URB (Urban Areas)  

?? MOB (Missile Order of Battle)  

?? SAM (Surface-to-Air Missile Facility)  

?? SSM (Surface-to-Surface Missile Facility)  

?? MSF (Missile Support Facility)  

?? NOB (Naval Order of Battle)  

?? UNT (Naval Units)  

?? NMI (Naval/Maritime Installations)  

?? UTL (Utilities)  

?? POL (Petroleum, Oil, Lubricants Storage and Refineries)  

?? PWR (Power Plants)  

?? TEL (Telecommunications)  



Allegiance Criteria 

The Allegiance Criteria area limits your query to only tracks that belong to a specific 
allegiance (country code).   The Allegiance Criteria area contains a list of countries.  To 
select an allegiance, click on the country you want to return tracks from.   
For example, if you only wanted to see Iraqi tracks, you would select Iraq from the 
Allegiance Criteria list. 

Geographic Location Criteria 

The Geographic Location Criteria area limits your query to a specific location on the 
map.   
You can type coordinates into the location text boxes or enter coordinates using the 
GeoSearch tool bar.  The GeoSearch tools are the easiest method of entering geographic 
criteria.  Table 1-2 lists the available GeoSearch tools.  The instructions below explain 
how to use each of the location filters. 

To use the box tool: 

?? Click on the box icon in the toolbar.  On the map, press and hold the 
button at the corner of your box search, and draw your box.  Release the 
button when finished. 

The box’s coordinates are entered into the Geographic Location Criteria 
(box). 

To use the circle tool: 

?? Click on the circle icon on the toolbar.  On the map, press and hold the 
button at the center of your circle search, and draw your circle.  Release 
the button when finished. 

The circle’s coordinates are entered into the Geographic Location 
Criteria (box). 

To use the polygon tool: 

?? Click on the polygon icon on the toolbar.  On the map, click and release 
the button at your first corner; move the cursor to the next corner, click 
and release the button.  Repeat this procedure for all corners of the 
polygon.  After the last corner of the polygon has been drawn, double-
click the corner to end the polygon. 

The polygon’s coordinates are entered into the Geographic Location 
Criteria (box). 



To use the route tool: 

Step 1. Click on the route icon on the toolbar.  On the map, click and release the 
button at your first point; move the pointer to the next point, click and 
release the button.  Repeat this procedure for all points of the route.  After 
the last leg of the route has been drawn, double-click the button to end the 
route. 

The route’s coordinates are entered into the Geographic Location 
Criteria (box). 

Step 2. Set the Route Half Width for the query.  

Creating and Running a Query 

To query using Land Track Query: 

Step 1. Go to the Track Plot menu, and select Land Track Query. 

The Land Track Query window appears (see Figure 1-24).  The window is 
divided into three areas:  Query Criteria, Allegiance Criteria, and 
Geographic Location Criteria.   



 

Figure 1-24.  Land Track Query Window 

Step 2. Go to the Data View menu, and select a data type, National View, 
Observations, or Local View. 

The data view determines what types of tracks are returned by the query.  
For example, selecting National View will only return National data. 

NOTE: The Local View option includes both reviewed Tactical data and National data; 
therefore, it is frequently updated and valuable for querying purposes. 

Step 3. (Optional) Go to the Data View menu, and select the Imagery Only 
option. 

The Imagery Only option only displays tracks that have associated 
imagery.  



Step 4. Select the type(s)/sub-type(s) from the Query Criteria area.   

The default is all subtypes empty.  Clicking a sub-type selects it, filling the 
symbol. 

The toolbar contains four buttons under Edit that assist with selecting 
symbols: Select All, Deselect All, Select All Units, and Select All 
Facilities (see Table 1-2 for more information). 

Step 5. (Optional) Select an allegiance (Country Code name) from the Allegiance 
Criteria area. 

Step 6. (Optional) Enter a geographic coordinate into the Geographic Location 
Criteria area. 

Enter coordinates into the field entry boxes by typing them directly into 
the box, or enter them by drawing the search area using the location filters.   

Step 7. From the File menu, select Run Query; or click the Run Query button on 
the toolbar (see Table 1-2.  Land Track Query Toolbar). 

A Land Track Query Task Monitor window appears, indicating the query 
is in progress.   

?? To stop the query, click Stop.   

?? If the query is halted, click Resume  to continue the query or Finish to 
stop running the query.   

The tracks are plotted automatically during the query. 
 

 

Saving Search Criteria/Results 
Saving the Search Criteria and Results (as a .xls File) 



15. To save the search criteria and results: 

Step 1. Go to File and select Save As (see Figure 1-34). 

 

Figure 1-34. File Menu 

Step 2. Enter the file name in the Save As dialog box (see Figure 1-45). 



 

Figure 1-45. Save As 

Step 3. Ensure the file type is an .xls file and click Save. 

Opening a .xls File  
Intel Office provides an option to open an existing .xls file.   

NOTE: This does not refresh the spreadsheet or search the database for new records. 

16. To open a .xls file: 

Step 1. Go to File and select Open.  

Step 2. Navigate to the folder where the search was saved. 

Step 3. Select the saved search (search will have an .xls extension). 

Step 4. Click Open. 



Refreshing the Excel Spreadsheet 
Intel Office provides a refresh option that only updates the records in the spreadsheet. It 
does not add any new records.    

17. To Refresh the Excel Spreadsheet: 

Step 1. Go to Intel menu and select Refresh Data or select Refresh on the Intel 
Toolbar. 

The current spreadsheet will refresh the records. 

Step 2. Select Done  when refresh completes. 

 
Requerying for Associations 
Intel Office allows the user to perform a specific query and then allows the user to 
Requery that search for any associations, such as imagery, remarks, equipment, 
subordinate units or facilities, targets and URL’s.  

18. To Requery for Associations: 

Step 1. After completing a Search, go to the Intel menu and select Options .  

 The Options window appears.  

Step 2. Select the Associations and Paths  tab and choose the Associations  to 
requery and click OK. 

Step 3. Go to the Intel menu and select Requery for Associations   

 A progress bar appears and Intel Office performs the Requery for 
Associations . 

Step 4. Select Done  when the Requery is finished. 

Any Associations will be listed in the spreadsheet. 
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Adding, Modifying, and Deleting Intelligence Data 

Use Intel Office to add, modify, or delete records and information on units, facilities, and 
observations.   

?? Updating the GMI to reflect the most current intelligence situation is done 
directly in the Excel Spreadsheet. 

Adding a New Record  
Adding a New Facility, Unit, Equipment, or Observation from the Spreadsheet 

19. To add a new facility, unit, equipment or observation from the 
spreadsheet: 

Step 1. Go to the Intel menu choose New Intel and select Facility, Unit, 
Equipment, or Observation.  

A highlighted row is entered in the spreadsheet. 

Step 2. Enter data into the spreadsheet in the appropriate columns.   

 Intel Office minimally requires unit or facility name.  

Step 3. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 4. On the Commit message box, select Yes.   

Step 5. Save changes.  

Adding New Associated Equipment, Facilities or Units from the Spreadsheet 

20. To add a new associated equipment, facilities or units from the 
spreadsheet: 

Step 1. Insert a row into the spreadsheet. 

WARNING: Row 5 in the spreadsheet should not be selected for adding associations.   

Step 2. Enter the information into the appropriate cells of the new row. 

Associated facilities and units minimally require the unit or facility name.  

Associated equipment minimally requires equipment name and quantity 
on hand. 

Step 3. Highlight the new row and Highlight the record to add the associated 
equipment, facility or unit. 



Step 4. Go to the Intel menu and choose Add Association, or select Add 
Association from the Intel Toolbar. 

 

Step 5. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 6. Save changes.   

Adding an Associations to existing Records 

Step 1. Highlight the Records in the spreadsheet to associate. 

Step 2. Go to the Intel menu and choose Add Association, or select Add 
Association from the Intel Toolbar. 

Step 3. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 4. Save changes. 

Adding Remarks 

Step 1. Select the record to add remarks. 

Step 2. Go to the Remarks column in the spreadsheet that corresponds with the 
record to add the remarks. 

Step 3. Type the remarks about the record in that cell. 

Step 4. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 5. Save changes. 

Modifying a Facility or Unit 
Modifying a Facility or Unit from the Spreadsheet 
You can modify the data on any existing facility or unit right from the spreadsheet.   

To modify a facility or unit from the spreadsheet: 

Step 1. From the Excel spreadsheet, select a cell from the row you wish to 
modify. 

Step 2. Enter the updated information into the cell. 

Step 3. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 4. A window will appear asking to confirm commit changes.  Click Yes. 



Step 5. Save changes. 

Deleting a Facility, Unit, or Observation; or Breaking Associations 

NOTE: National records cannot be deleted.  An error message will appear when the user 
attempts to do so.  

Deleting a Facility, Unit, or Observation from the Spreadsheet 
You can delete an existing facility, unit, or observation right from the spreadsheet.   

To delete an existing Facility, Unit, or Observation from the spreadsheet: 

Step 1. From the Excel spreadsheet, select the complete row to delete. 

Step 2. Delete the row. 

Step 3. Go to the Intel menu and select Commit Changes, or select the Commit 
Changes button on the Intel toolbar at the bottom of the spreadsheet. 

Step 4. Save changes. 

Breaking Existing Associations from the Spreadsheet 

To Break an existing Association from the Spreadsheet: 

Step 1. Highlight the associated records to break their association. 

Step 2. Go to the Intel menu and select Break Association or select Break 
Association from the Intel toolbar at the bottom of the spreadsheet. 

Step 3. Save changes. 

Deleting Remarks 

To Delete Remarks from the Spreadsheet: 

Step 1. Go to the Remarks column in the spreadsheet, and choose which records 
remarks to delete.   

Step 2. Highlight the Remarks cell of the record whose remarks are to be 
removed. 

Step 3. Delete the remarks by selecting Delete  on the keyboard. 

Step 4. Save Changes. 

Intelligence Products 



Intel Office provides dissemination capabilities such as: viewing and printing the 
intelligence reports; and viewing, formatting, and printing the Excel spreadsheet.   

NOTE: To view the Intelligence Report, Imagery Report, or Related Messages, Intel 
Office must be configured to connect with the appropriate SDS, ITS, JHMS, 
JETS, etc. 

Viewing an Intelligence Report 
The Intelligence Report provides the most detailed information on a Unit or Facility.  The 
report uses a Web browser to display data.   

To view a Intelligence Report: 

Step 1. Select the row of the record to view from the spreadsheet, go to Intel and 
select Intel Report. 

The default Web browser launches with the Intel Report for the selected 
record (see Figure 1-16).  

 

Figure 1-16.  Intelligence Report  



Printing an Intelligence Report 

21. To print an Intelligence Report: 

Step 1. Open the Intelligence Report to print. (See Viewing an Intelligence Report 
for information on how to display the Intelligence Report.) 

Step 2. From the browser window, go to the File menu and select Print.   

The Intel Report prints out on the connected printer. 

Viewing Related Messages 

22. To view messages related to the report: 

Step 1. Display the Intelligence Report for the record.  (See Viewing an 
Intelligence Report for information on how to display the Intelligence 
Report.) 

Step 2. Click the Search Messages link. 

This launches the JMCIS Expedited Text Search (JETS) Message Search 
application. 

Step 3. Click Search Now to begin the search. 

Viewing the Imagery Report 

NOTE: An ITS/DPS user account must be used to view the Imagery Report. 

23. To view related imagery: 

Step 1. Select a record. 

Step 2. Go to the Intel menu and select Imagery Report. 

The default Web browser launches with the Imagery Report for the 
selected record (see Figure 1-17). 

NOTE: Imagery can also be viewed by clicking on the hyperlink in the spreadsheet.  



Plotting Land Tracks to the C2PC Chart 

NOTE: C2PC needs to be open in order to plot to the map. 

24. To plot Land Tracks on the C2PC chart: 

Step 1. Select entire spreadsheet, or individual records to plot. 

Step 2. Go to Intel and select Plot To Map.   

The selected records are plotted on the C2PC chart. 

Viewing an Intelligence Report from a Plotted Land Track 

25. To view an Intelligence Report from a plotted land track: 

Step 1. Right-click on a plotted land track. 

Step 2. Select Quick Report from the pop-up menu. 

The Quick Report window displays. 

Step 3. (Optional) To view the entire Intelligence Report from the Quick Report 
window, go to Tools, and select Display Report. 

Saving Land Tracks Plotted on C2PC 

26. To save land tracks plotted on C2PC: 

Step 1. From the C2PC window, go to Database and select Save As. 

The Save As dialog window displays. 

Step 2. Give the saved land tracks a name and click Save. 

Formatting the Excel Worksheet 

27. To format the Excel worksheet: 

?? Excel formatting options, such as sorting and hiding rows, are available within 
Intel Office. 

?? Refer to Excel documentation or online help for additional formatting 
procedures. 

?? Changes made to the data in the Excel spreadsheet are not entered into the 
local view until the changes are committed.  

Printing the Excel Worksheet 

To print the Excel worksheet: 

Step 1.      Go to the File menu and select Print. 



Step 2. Enter the number of copies and other information needed, and select OK. 
Sending Data to Falcon View 

28. To send to Falcon View: 

Step 1. Go to the Intel menu and select Send Intel to Falcon View or select the 
Send to Falcon View on the Intel Toolbar.  

The Save As dialog window displays. 

Step 2. Enter the file and click Save. 

The .thr (threat overlay) and .lpt (local points) files are saved. 

Step 3. Open the files from Falcon View. 

 
 


